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Preface

Oracle Resources
Important: For the latest version of this document, visit the SAN Storage – Oracle
Flash Storage Systems section at the Oracle Help Center (http://www.oracle.com/
goto/fssystems/docs).

Table 1: Oracle resources
For help with... Contact...
Support http://www.oracle.com/support

(www.oracle.com/support)

Training https://education.oracle.com
(https://education.oracle.com)

Documentation • SAN Storage – Oracle Flash Storage Systems:
(http://www.oracle.com/goto/fssystems/docs)

• From Oracle FS System Manager (GUI):
Help > Documentation

• From Oracle FS System HTTP access:
(system-name-ip/documentation.php
where system-name-ip is the name or the public IP
address of your system)

Documentation
feedback

http://www.oracle.com/goto/docfeedback
(http://www.orarcle.com/goto/docfeedback)

Contact Oracle http://www.oracle.com/us/corporate/contact/index.html
(http://www.oracle.com/us/corporate/contact/
index.html)

Related Documentation
• Oracle Flash Storage System Glossary

• Oracle FS1-2 Flash Storage System Installation Guide (Racked)

• Oracle FS1-2 Flash Storage System Installation Guide (Not Racked)

• Oracle FS1-2 Flash Storage System Customer Service Guide

• Oracle Flash Storage System Administrator’s Guide

• Oracle FS1-2 Flash Storage System Release Notes
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CHAPTER 1

System Expansion

Overview
To accommodate increased storage demands and to expand the storage pool
available to the Oracle FS System, you can add Drive Enclosures to the system.
You can combine additional DE2-24P Drive Enclosures and DE2-24C Drive
Enclosures in the same system.

You can also expand storage by adding groups of six solid state drives (SSDs) to
Drive Enclosures currently configured with seven SSDs (400GB or 1.6TB) or 13
SSDs (1.6TB).

Note: Adding Drive Enclosures requires planning and careful implementation.
To ensure a trouble-free installation, allow the necessary time to develop a plan
and double-check the resources available.

This document focuses on the installation of newly added Drive Enclosures and
presumes that appropriate planning took place.

Note: Planning requires assistance from your Oracle Sales Engineer.

The output of the planning process includes a completed Oracle FS1-2 Expansion
Planning Worksheet. The planning worksheet provides the details needed to
order new Drive Enclosures and cables.

Planning Steps Overview
Thorough planning helps ensure that the process of expanding a system goes
smoothly.

System expansion involves planning steps that help determine the system’s
current configuration, circumstances that require acquiring longer cables, and
provisioning steps that require other coordination.

The following sections summarize the high-level planning steps.

Note: Work with your Oracle Sales Engineer to complete the following planning
steps prior to ordering the new Drive Enclosures.

Determine the Expansion Method
Before you begin, determine which of the following expansion methods works
best for your environment:
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Online
expansion
(release 6.2.0
or later)

With an online expansion, you can keep the Oracle FS System in
production during the process of adding Drive Enclosures to the
system. Use the Guided Maintenance feature of Oracle FS System
Manager (GUI) (version 6.2.0 and later) to add Drive Enclosures,
one at a time, to the system. If the GUI is not available, you can
manually add Drive Enclosures, one at a time, to the system
while the system remains in production.

Note: Oracle recommends using Guided Maintenance.

Offline
Expansion

With an offline expansion, you can shut down the system and
then manually add Drive Enclosures to the system. An offline
expansion lets you add multiple Drive Enclosures, at the same
time, to the system.

Note: Systems running version 6.1.x of the software require the
system to be offline when adding Drive Enclosures.

Determine the State of the System
During this planning step, access the system for the current configuration details
and verify the following items:

• Ensure that the system software is up-to-date. Use of Guided Maintenance
requires software version 6.2.0 or later.

• Gather the SAS topology map from the system to verify the Drive
Enclosure string topology.

• Ensure that there are no topology rule violations.

• Using the chassis IDs of the installed Drive Enclosures and the SAS
topology map, verify the physical arrangement of the installed Drive
Enclosures and strings in your system.

Determine the Current SAS Topology
Your Oracle Sales Engineer determines which of the following scenarios
describes the current SAS topology of the Drive Enclosures in your system:

• The connections and the physical arrangement of the Drive Enclosures
match the initial factory configuration.

• One or more Drive Enclosures have been added to a factory configuration
and meet the configuration guidelines.

• Your system functions properly, but the configuration does not meet the
configuration guidelines.

• The system has validation errors or other problems.

Note: The planning process for system expansion is more efficient with systems
that are maintained in a standard configuration.

System Expansion
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Determine the String Numbers and Locations
Your Oracle Sales Engineer analyzes the SAS topology configuration of your
system to determine the string number and the location of each new Drive
Enclosure within the strings for your system.

Determine a Time to Install the New Drive Enclosures
Installation should occur during a system offline maintenance period or during a
time when the system load is low.

Note: The system is designed so that you can expand the available storage pool
during production while the system remains online. Keeping the system in
production during expansion has the following requirements:

• The system environment has been designed and maintained in a proper
state to allow for an upgrade to be successful.

• You, or someone that you designate, must be knowledgeable in the
technical aspects of the system, as well as the system environment, prior to
performing the expansion. Otherwise, complete the procedure offline in a
maintenance window or contact your Oracle Sales Engineer for assistance.

Related Links
Expansion Planning Worksheet
Sample Topology Output

Expansion Planning Worksheet
During the planning process, work with your Oracle Sales Engineer to complete
the Oracle FS1-2 Expansion Planning Worksheet. The worksheet helps you define
the Drive Enclosures to be added to your system, the rack locations of the new
Drive Enclosures, and the connectivity and cabling requirements.

Use the information defined in the worksheet to create your order for the new
Drive Enclosures and the necessary cables.

Note: Cables are not included when you order Drive Enclosures. Make sure that
you include the required cables in your order.

The following example shows a sample worksheet for adding a Drive Enclosure
to a system with two Drive Enclosures currently installed.

Table 2: Oracle FS1-2 expansion planning worksheet (sample)

Customer information Requirements

Customer name

Customer contact

System location

System Expansion
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Table 2: Oracle FS1-2 expansion planning worksheet (sample) (continued)

Customer information Requirements

Date of site survey

Oracle Sales Engineer

Oracle account team

Configuration of existing system

Standard configuration (yes/no): Yes

Number of racks: 1

Number of SAS HBAs per Controller: 1

Number of DEs installed in the system: 2

Number of strings defined in the system: 2

Oracle racks (yes/no): Yes

Non-FS system equipment to avoid: None

If expanding into a new rack, are the side panels
removed? (yes/no):

N/A

Configuration of Drive Enclosure currently in the system (repeat for each DE
installed in the system)

Type of Drive Enclosure (Performance SSD, Capacity
SSD, Performance HDD, Capacity HDD):

Perf SSD

Chassis ID: 01

String number: 1

DE location in the string: 1

Rack number: 1

Rack unit (RU): 1-2

Type of Drive Enclosure (Performance SSD, Capacity
SSD, Performance HDD, Capacity HDD):

Perf SSD

Chassis ID: 02

String number: 2

System Expansion
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Table 2: Oracle FS1-2 expansion planning worksheet (sample) (continued)

Customer information Requirements

DE location in the string: 1

Rack number: 1

RU: 3-4

Configuration of New Drive Enclosure (repeat for each new DE)

Type of Drive Enclosure (Performance SSD, Capacity
SSD, Performance HDD, Capacity HDD):

Cap HDD

DE Add Order number: 3

String number: 1

DE location in the string: 2

Rack number: 1

RU: 5-8

Expected chassis ID: 03

Connection details for IOM 0, Port 0

IOM 0, port 0 connects to: DE 01, IOM 0, port 1

Cable type: DE to DE

New cable required (yes/no): Yes

Cable length (3 meters = same rack; 6 meters = different
rack

3M

Connection details for IOM 1, Port 0

IOM 1, port 0 connects to: Controller 02, HBA, PCI
slot 3, port 0

Cable type: CU to DE

New cable required (yes/no): No, move existing cable

Cable length: 9.84 feet (3 m) in the same rack; 19.69 feet
(6 m) in a separate rack

9.84 feet (3m)

Connection details for IOM 1, Port 1

System Expansion
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Table 2: Oracle FS1-2 expansion planning worksheet (sample) (continued)

Customer information Requirements

IOM 1, port 1 connects: DE 01, IOM 1, port 0

Cable type: DE to DE

New cable required (yes/no): Yes

Cable length: 9.84 feet (3 m) in the same rack; 19.69 feet
(6 m) in a separate rack

9.84 feet (3m)

The following example shows a sample summary of the new cables required for
adding Drive Enclosures.

Table 3: New cables summary worksheet (sample)

Cables Quantity

Cables for connecting Controllers to Drive Enclosures

Cable assembly: 3 meters, mini-SAS to mini-SAS HD; P/N
7104928

Cable assembly: 6 meters, mini-SAS to mini-SAS HD; P/N
7104929

Cables for connecting Drive Enclosure to Drive Enclosure

Cable assembly: 9.84 feet (3 m), mini-SAS 4x cable, shielded; P/N
7104939

2

Cable assembly: 19.69 feet (6 m), mini-SAS 4x cable, not
equalized; P/N 7104944

Related Links
Sample Topology Output
Drive Enclosure Strings

Installation Steps Overview
After working with your Oracle Sales Engineer to create an expansion plan,
receiving all of the new Drive Enclosures and cables, and arranging for a suitable
time to implement the expansion plan, you can begin to install and cable the new
Drive Enclosures.

Workflow for installing and cabling new Drive Enclosures

System Expansion
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1 Review SAS Cabling Overview

2 Validate the Current State of the System

3 Install New Drive Enclosures in a Rack

4 Prepare the System for Cabling New Drive Enclosures

5 Cable the new Drive Enclosures

• Cable a New Drive Enclosure (Guided Maintenance)

• Cable a New Drive Enclosure (Manual)

6 Complete the Expansion Process

System Expansion
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CHAPTER 2

SAS Cabling Overview

Drive Enclosure Strings
A Drive Enclosure string is a collection of Drive Enclosures that are connected by
a common cable to the same SAS HBA port on both Controllers. A string consists
of one to five Drive Enclosures. A system can have up to six strings, depending
upon the number of SAS HBAs installed.

The position of a Drive Enclosure within the SAS topology is determined by the
string number and the location of the Drive Enclosure within the string. The
location is determined by the order in which a given Drive Enclosure was added
to the string. The location defines the cable connections for that Drive Enclosure.

For a system expansion to work properly, ensure that the Drive Enclosures and
string distribution adhere to the following guidelines:

• Drive Enclosures are distributed among the strings so that all of the
available SAS HBA ports designated for Drive Enclosures are used as
equally as possible. The number of Drive Enclosures on the shortest string
should not differ from the number Drive Enclosures on the longest string
by more than one Drive Enclosure.

• Strings are filled in numerical order. No higher numbered string has more
Drive Enclosures installed than a lower numbered string.

The following figure shows a base system with two strings. In a performance
system where three SAS HBAs are installed per Controller, the arrangement of
the Drive Enclosures within each string is the same as for base systems. In the
following figure, the connections between Controller 1 and I/O module 0 (IOM 0)
are shown in red. The connections between Controller 2 and I/O module 1 (IOM
1) are shown in green. The connections between Controller 1 and Controller 2,
which mirror the SAS cross connections, are shown in purple.
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Figure 1: SAS string topology

Legend 1 IOM 0, port 0, always an ingress
port connecting from Controller 1,
SAS HBA port 0 or port 1, or from
IOM 0, port 1 or port 2 of an
upstream DE

4 IOM 1, port 0, always an ingress port
connecting from Controller 2, SAS
HBA port 0 or port 1, or from IOM 1,
port 1 or port 2 of an upstream DE

2 IOM 0, port 1, always an egress
port connecting to IOM 0, port 0
of a downstream DE

5 IOM 1, port 1, always an egress port
connecting to IOM 1, port 0 of a
downstream DE

3 IOM 0, port 2, always an egress
port connecting to IOM 0, port 0
of a downstream DE

6 IOM 1, port 2, always an egress port
connecting to IOM 1, port 0 of a
downstream DE

Note: The system derives the Controller 1 and Controller 2 designation from the
order that the Pilot software discovers the Controllers at the time the system is
brought up for the first time. Oracle’s racked system manufacturing process
ensures that the Controllers are installed in the rack in the expected order and
that the chassis ID values match the order. The designations are stored in the
“Configuration on Disk” primary metadata.
Note: The Controller 1 and Controller 2 designations are part of the way that
string numbers are derived. Each Controller has a chassis ID, and you can use

SAS Cabling Overview
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Oracle FS System Manager (GUI) or Oracle FS System CLI (FSCLI) to change the
chassis IDs. Changing the chassis ID of a Controller does not change the internal
Controller designation.

Related Links
Expansion Planning Worksheet
Sample Topology Output
Cable a New Drive Enclosure (Manual)

Chassis ID Numbers on Drive Enclosures
Each Drive Enclosure has a chassis ID number. The chassis ID number uniquely
identifies each Drive Enclosure in an Oracle FS System.

Chassis ID Assignments
As part of the initial build process, the system assigns chassis IDs to Drive
Enclosures based on their location within the discovered topology. If the Drive
Enclosures are cabled according to the factory recommendation, the chassis IDs
align with the physical location of the Drive Enclosures in the rack. After a Drive
Enclosure has been assigned a chassis ID, the value is persistent across system
warm starts and cold starts. You can change the chassis ID for a Drive Enclosure,
if necessary, to accurately reflect the physical location of the Drive Enclosure in
the rack.

With a factory configuration, chassis ID numbers begin with 01 at the bottom of
the left-most rack. The chassis ID numbers increment to the top of a rack and left
to right across multiple racks. This assignment of chassis IDs is recommended for
all systems to aid service personnel in locating the system components.

For systems with the factory configuration that have not been expanded, the
Drive Enclosures are arranged so that the Drive Enclosures in each string are
physically adjacent. The Drive Enclosures have consecutive chassis ID numbers.

When adding Drive Enclosures, the system assigns the next available chassis ID
value to each newly discovered Drive Enclosure. If chassis ID values were
modified in the system, a newly added Drive Enclosure might be assigned a
chassis ID value that is lower than the previously installed Drive Enclosures.

Be aware that after successfully expanding a system, the Drive Enclosures in a
string will no longer be adjacent in the rack, nor will they have consecutive
chassis ID numbers. This is expected and supported. You can use Oracle FS
System Manager (GUI) or Oracle FS CLI (FSCLI) to change the chassis IDs.

Note: It is not supported to attempt to physically reposition the Drive Enclosures
in the rack to maintain contiguous strings. Repositioning the Drive Enclosures in
the rack can create cable length issues, introduce too much time and risk to the
expansion procedure, and might require the system to be taken offline.

SAS Cabling Overview
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Very few circumstances cause the chassis ID values to display out of order. Most
of those circumstances indicate that an error has occurred. Be careful when
modifying chassis ID values.

An example of an out of order chassis ID is on a system restart when the system
was shut down in order to add several new Drive Enclosures. On startup, the
system assigns chassis ID numbers to each of the new Drive Enclosures.

If the system cannot find one of the new Drive Enclosures (for example, the Drive
Enclosure was not properly powered on or cabled) then that Drive Enclosure will
not be assigned a chassis ID number. Once the issue is resolved, the system
assigns the next available chassis ID number to that Drive Enclosure. Ensure that
you understand the root cause of any chassis ID coming up out of order before
proceeding.

Chassis ID Display Locations
The chassis IDs are displayed on the front, lefthand side of each Drive Enclosure.
The chassis IDs are also displayed in Oracle FS System Manager (GUI) and in the
topology map output.

The following figure shows an example of the chassis ID displayed on the Drive
Enclosure chassis.

Figure 2: Chassis IDs displayed on the Drive Enclosure chassis

Legend 1 Chassis ID 01 (DE2-24P Drive
Enclosure)

2 Chassis ID 02 (DE2-24C Drive
Enclosure)

The following figure shows an example of the chassis ID displayed on the Drive
Enclosure Overview page.

SAS Cabling Overview
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Figure 3: Chassis IDs displayed on the Drive Enclosure Overview page

Legend 1 Chassis ID 01 2 Chassis ID 02

The following figure shows an example of the chassis ID displayed in the
topology output.

Figure 4: Chassis IDs displayed in the topology output

Legend 1 Chassis ID 01 2 Chassis ID 16

Add Order Number of Drive Enclosures
The Add Order Number of a Drive Enclosure is the numeric value that
corresponds with the order that the Drive Enclosure is installed or added to an
Oracle FS System. Use the Add Order Number to look up the string number and
location of a Drive Enclosure within the string.

When adding Drive Enclosures to a system, the first Drive Enclosure to be added
has an Add Order Number equal to the number of existing Drive Enclosures in
the system plus one.

SAS Cabling Overview
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For example, if a system has six Drive Enclosures installed, then the next Drive
Enclosure to be added is Add Order Number 7. If the system follows the factory
configuration, the chassis ID numbers of the existing Drive Enclosures are 01-06,
and the newly added Drive Enclosure is assigned chassis ID number 07.

Note: Depending on the history of the system configuration, the Add Order
Numbers might not match the chassis IDs values of the Drive Enclosures in the
system.

Note: The chassis IDs should reflect the cabling string order. You can use
Oracle FS System Manager (GUI) or Oracle FS CLI (FSCLI) to modify the chassis
IDs to reflect the cabling string order. Exercise caution when modifying chassis
IDs to ensure that the modifications reflect the proper order.

The following table shows the Drive Enclosure Add Order Numbers for a system
configured with one SAS HBAs per Controller.

Table 4: One SAS HBA per Controller

DE Add Order String
number

SAS HBA PCI
slot

Port on SAS
HBA

DE number within
string

1 1 Slot 3 0 1

2 2 Slot 3 1 1

3 1 Slot 3 0 2

4 2 Slot 3 1 2

5 1 Slot 3 0 3

6 2 Slot 3 1 3

7 1 Slot 3 0 4

8 2 Slot 3 1 4

9 1 Slot 3 0 5

10 2 Slot 3 1 5

The following table shows the Drive Enclosure Add Order Numbers for a system
configured with two SAS HBAs per Controller.

SAS Cabling Overview
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Table 5: Two SAS HBAs per Controller

DE Add Order String
number

SAS HBA PCI
slot

Port on SAS
HBA

DE number within
string

1 1 Slot 3 0 1

2 2 Slot 6 0 1

3 3 Slot 3 1 1

4 4 Slot 6 1 1

5 1 Slot 3 0 2

6 2 Slot 6 0 2

7 3 Slot 3 1 2

8 4 Slot 6 1 2

9 1 Slot 3 0 3

10 2 Slot 6 0 3

11 3 Slot 3 1 3

12 4 Slot 6 1 3

13 1 Slot 3 0 4

14 2 Slot 6 0 4

15 3 Slot 3 1 4

16 4 Slot 6 1 4

17 1 Slot 3 0 5

18 2 Slot 6 0 5

19 3 Slot 3 1 5

20 4 Slot 6 1 5

The following table shows the Drive Enclosure Add Order Numbers for a system
configured with three SAS HBAs per Controller.

SAS Cabling Overview
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Table 6: Three SAS HBAs per Controller

DE Add Order String
number

SAS HBA PCI
slot

Port on SAS
HBA

DE number within
string

1 1 Slot 3 0 1

2 2 Slot 6 0 1

3 3 Slot 2 0 1

4 4 Slot 3 1 1

5 5 Slot 6 1 1

6 6 Slot 2 1 1

7 1 Slot 3 0 2

8 2 Slot 6 0 2

9 3 Slot 2 0 2

10 4 Slot 3 1 2

11 5 Slot 6 1 2

12 6 Slot 2 1 2

13 1 Slot 3 0 3

14 2 Slot 6 0 3

15 3 Slot 2 0 3

16 4 Slot 3 1 3

17 5 Slot 6 1 3

18 6 Slot 2 1 3

19 1 Slot 3 0 4

20 2 Slot 6 0 4

21 3 Slot 2 0 4

22 4 Slot 3 1 4

23 5 Slot 6 1 4

24 6 Slot 2 1 4

SAS Cabling Overview
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Table 6: Three SAS HBAs per Controller (continued)

DE Add Order String
number

SAS HBA PCI
slot

Port on SAS
HBA

DE number within
string

25 1 Slot 3 0 5

26 2 Slot 6 0 5

27 3 Slot 2 0 5

28 4 Slot 3 1 5

29 5 Slot 6 1 5

30 6 Slot 2 1 5

SAS Cabling Precautions
During the system expansion process, the SAS cables are added. Depending on
the configuration of your Oracle FS System, SAS cables might require
rearranging between Controllers and Drive Enclosures.

Exercise care when adding and rearranging SAS cables and observe the
following guidelines:

• Route cables so that future maintenance actions are not hindered. In
particular, make sure that none of the replaceable components are blocked
by cables.

• Use the cable management arms (CMAs) to route cables to the Controllers.
Ensure that the Controllers slide to the fully extended service position to
maintain proper access to the replaceable components inside of the
Controller. The CMAs facilitate access only if all newly installed cables are
properly secured.

• Ensure that the cables are not pinched in door latches or hinges.

• Dress cables neatly with gentle radius bends.

• Use hook-and-loop fasteners to bundle cables. Never use nylon tie-wraps
or metallic fasteners.

For more information about proper cabling, refer to Oracle FS1-2 Flash Storage
System Installation Guide.

Related Links
System Expansion Label Kit
Cable a New Drive Enclosure (Manual)
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SAS Resiliency
When adding Drive Enclosures to the second and third location within a string,
you must disconnect one of the two cables connecting the string to the
Controllers. To support continuous access to the data on the string during the
time of this disconnection, the Oracle FS System reroutes all traffic to that string
to the remaining Controller connection.

It can take the system up to 30 seconds for the system to reroute the data traffic.
During this time, the system is vulnerable to additional failures or errors. To
verify whether the system has stabilized, log into Oracle FS System Manager
(GUI) and monitor the System Alerts page (System > Alerts and Events >
System Alerts).

Expect event messaging that shows the topology rule violations that corollate
exactly to the cable pulls. If, for example, you disconnect a Drive Enclosure port
in the path of Controller 01, you should expect messaging related to Controller
01.

You might see up to 48 of the same message, one per drive with one disconnected
cable. The following table shows examples of messaging to expect.

Table 7: Expected messaging

Types of
messages

Example of messaging to expect

Alerts Fabric Topology Warning (on System Alert Screen)
PITMAN Topology Change Warning (on Event log)
Foreign Drive Type (on System Alert Screen)

Warnings Enclosure Component State Change (on Event log)
Storage Fabric Path Failure (on Event log)

Informational Degraded Connectivity (on Event log)
PITMAN Topology Change OK (on Event log)
New Drive Group (on Event log)

If you receive events other than the expected events, correct them prior to
proceeding to ensure there are no unexpected or compromising issues. After the
system stops generating the expected events, you can proceed.

Topology Validation Overview
While the Oracle FS System is running, any change in the SAS topology, such as
disconnecting or connecting a cable, causes the system to check the topology for
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alerts. Continuously monitor the alerts during the expansion procedure to assure
that no topology violations occur.

It can take up to 30 seconds for the system to post alerts. Use Oracle FS System
Manager (GUI) or Oracle FS CLI (FSCLI) to monitor the system alerts:

• Using the GUI, navigate to System > Alerts and Events > System Alerts.

• Using the FSCLI, issue fscli topology -list -violations.

Related Links
Sample Topology Output
Validate the Current State of the System
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CHAPTER 3

Installing Drive Enclosures in the Rack

Validate the Current State of the System
Before installing new Drive Enclosures, it is imperative that the current state of
the Oracle FS System matches the state of the system when the expansion plan
was created. Changes in the SAS topology and the configuration of Drive
Enclosure strings between the time that the expansion plan was completed and
the time of the installation can render the plan invalid. Changes can also be
potentially dangerous to system stability.

Prerequisites: • The current version of Oracle FS System Manager (GUI) is
installed on your client workstation.

• The current version of Oracle FS CLI (FSCLI) is installed on
your client workstation.

For details about updating the GUI and the FSCLI, refer to Oracle
Flash Storage System Administrator’s Guide.

Important: If the current state of the system does not match the state of the
system when the expansion plan was created, stop the installation and consult
with your Oracle Sales Engineer.

1 Make sure that the system has no topology violations.

a) Using an account set up with support role privileges, log into the
FSCLI and issue fscli topology -list -violations.

b) Correct any topology violations before proceeding.

2 Gather the current state of the system’s SAS topology and configuration of
Drive Enclosure strings.

a) Log into the FSCLI and issue fscli topology –download –
topomap <output-text-file>.

The system returns a file containing the topology map.

b) Compare the current topology map with the topology map captured
during the planning process.

The topology map contains the SAS topology and the current
configuration of Drive Enclosure strings. If the current topology map
matches the topology map captured during the planning process,
proceed with the installation of the new Drive Enclosures.
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Otherwise, analyze the topology map to determine if the system can
be updated in a straightforward way.

For a system expansion to work properly, the Drive Enclosures that
are currently installed must meet the following criteria:

• The SAS topology must be free from rule violations.

• Drive Enclosures and strings distribution adhere to the
recommended guidelines.

Related Links
Sample Topology Output
Topology Validation Overview

Install New Drive Enclosures in a Rack
After receiving and unpacking the new Drive Enclosures and accessories,
prepare the racks and set up the Drive Enclosures in the racks.

Prerequisite: You have access to Oracle FS1-2 Flash Storage System Customer
Service Guide.

Note: Contact your Oracle Sales Engineer if you need assistance with your order.

1 (Optional) Upgrade the racks and power distribution units (PDUs).

For more information about racks and PDUs, refer to Oracle FS1-2 Flash
Storage System Customer Service Guide.

2 Install the rack rails for each new Drive Enclosure.

For detailed instructions about installing rack rails, refer to Oracle FS1-2
Flash Storage System Customer Service Guide.

3 Install each new Drive Enclosure into the rack slot identified in your
expansion plan.

For detailed instructions about installing Drive Enclosures into racks, refer
to Oracle FS1-2 Flash Storage System Customer Service Guide.

4 Attach the power cords, and then power on the new Drive Enclosures.

Note: Do not attach any of the SAS cables at this time.

Installing Drive Enclosures in the Rack
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CHAPTER 4

Cabling New Drive Enclosures

Types of SAS Cables
Mini-SAS to mini-SAS HD cables connect Controllersto Drive Enclosures. Mini-
SAS to mini-SAS cables connect Drive Enclosures to Drive Enclosures.

SAS Cables for Drive Enclosure-to-Controller Connections
The following table lists the types of mini-SAS to mini-SAS HD cables and the
lengths of the cables used to connect a Drive Enclosure to a Controller.

Table 8: Mini-SAS to mini-SAS HD cables

Cable Color Cable path Cable length

Mini-SAS to
mini-SAS HD

Black Connects a
Controller to a Drive
Enclosure that is in
the same rack

9.84 feet

(3 m)

Mini-SAS to
mini-SAS HD

Black Connects a
Controller to a Drive
Enclosure that is in a
separate rack

19.69 feet

(6 m)

The following figure shows an example of mini-SAS to mini-SAS HD cable
connectors. The mini-SAS connector on one end of the cable connects to the
Drive Enclosure. The mini-SAS HD connector on the other end of the cable
connects to the Controllers.
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Figure 5: Example of mini-SAS to mini-SAS HD cable connectors

Legend 1 Mini-SAS connector
connects to Drive
Enclosures

2 Mini-SAS HD connector connects to
Controllers

SAS Cables for Drive Enclosure-to-Drive Enclosure Connections
The following table lists the types of mini-SAS cables and the lengths used to
cross connect Drive Enclosures

Table 9: Mini-SAS to mini-SAS cables

Cable Color Cable path Cable length

Mini-SAS to
mini-SAS

Black Connects a Drive
Enclosure to another
Drive Enclosure of
the same string in the
same rack

9.84 feet

(3 m)

Mini-SAS to
mini-SAS

Black Connects a Drive
Enclosure to another
Drive Enclosure of
the same string in
separate racks

19.69

(6 m)

The following figure shows an example of mini-SAS to mini-SAS cable
connectors.
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Figure 6: Example of mini-SAS to mini-SAS cable connectors

System Expansion Label Kit
A label kit is included with the shipment for expansion of the Oracle FS System.
Use the labels to designate the hardware component and the corresponding port
to which the cable connects and to identify the string assignment of an added
Drive Enclosure.

The following figure provides an example of a label that you attach to the end of
a SAS cable that connects to a Controller. In this example, the SAS cable connects
to PCIe slot 2, port 0 on Controller 01.

Figure 7: A label for the end of a cable that connects to the Controller

Legend 1 Controller 01 2 PCIe slot 2, port 0

The following figure provides an example of a label that you attach to the end of
a SAS cable that connects to a Drive Enclosure. In this example, the cable
connects to I/O module 0, port 2 on Drive Enclosure 10.
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Figure 8: A label for the end of a cable that connects to a Drive Enclosure

Legend 1 Drive Enclosure 10 2 I/O module 0, port 2

The following figure provides an example of a label that you attach to a SAS
cable to identify a Drive Enclosure string. In this example, the label identifies
string 4.

Figure 9: A label for a cable to identify string 4

Related Links
SAS Cabling Precautions
Cable a New Drive Enclosure (Manual)

Prepare the System for Cabling New Drive Enclosures
Cabling new Drive Enclosures in an Oracle FS System requires that you either
take the system offline or prepare the system to prevent unnecessary Call-Home
events.

Prerequisites: • The current version of Oracle FS System Manager (GUI) is
installed on your client workstation.

• The current version of Oracle FS CLI (FSCLI) is installed on
your client workstation.
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Note: If you plan to use Guided Maintenance when cabling the new Drive
Enclosures, do not take the system offline.

• If the plan is to take the system offline, use the GUI or the FSCLI to shut
down the system.

a) If you are using the GUI, select Oracle FS > Shut Down.

To verify the shutdown, navigate to Product > System Information.
The status of the shutdown process is displayed on the System
Information page.

b) If you are using the FSCLI, issue fscli system -shutdown.

To verify the shutdown, issue the command fscli system -list
and verify that the SystemStatus value is Shutdown.

If the shut down process fails, resolve the issues before proceeding.

• If the plan is to keep the system in production, use the GUI or the FSCLI to
disable Call Home.

a) If you are using the GUI, navigate to System > Networking and
select Actions > Modify > Notifications.

b) Clear the Enable event triggered Call-Home check box and click
OK.

c) If you are using the FSCLI, issue fscli call_home ‑modify
‑disableEventTrigger.

Related Links
Complete the Expansion Process

Overview of Cabling New Drive Enclosures
After installing new Drive Enclosures in the rack, you can use Guided
Maintenance to cable the new Drive Enclosures, or you can manually complete
the cabling steps.

Guided
Maintenance

As a feature of Oracle FS System Manager (GUI) (version 6.2.0
and later), Guided Maintenance guides you through the cabling
steps necessary to add new Drive Enclosures, one at a time, to
the Oracle FS System. Guided Maintenance displays images that
identify the SAS ports to which you connect the SAS cables.
Guided Maintenance automatically defines the cabling
connections so that the Drive Enclosure is distributed among the
strings and the available SAS HBA ports are used as equally as
possible.

Note: Oracle recommends using Guided Maintenance to
complete the cabling steps.

Cabling New Drive Enclosures
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Manual Manually cabling new Drive Enclosures involves following the
cabling sequences based on the Drive Enclosure number within
the string. If Guided Maintenance is not available, or if you
brought the system offline for the expansion, you must manually
complete the cabling steps.
Work with your Oracle Sales Engineer and refer to the expansion
planning worksheet, as well as the SAS topology output, to
determine the string assignments for each new Drive Enclosure
in the system.

Related Links
Planning Steps Overview
Drive Enclosure Strings

Cable a New Drive Enclosure (Guided Maintenance)
After installing the new Drive Enclosures, use Guided Maintenance to complete
the process of cabling the Drive Enclosures. Guided Maintenance guides you
through the process of cabling each new Drive Enclosure without disrupting
data access to the system.

Prerequisites: • The steps for planning the system expansion are complete.
• The new Drive Enclosures are installed in the rack and

powered on.
• The cables are unpacked and you have the correct mini-

SAS to mini-SAS cables and mini-SAS to mini-SAS HD
cables for adding the Drive Enclosures to the system. Refer
to your system expansion plan for details.

1 Log into Oracle FS System Manager (GUI).
2 Navigate to Hardware > Drive Enclosures, and select Actions > Add Drive

Enclosure.

The GUI initializes Guided Maintenance.
3 Follow the steps shown in Guided Maintenance.

Important: Carefully follow the steps in Guided Maintenance. Removing or
inserting a cable in the wrong location or at the wrong time can disrupt
data access to existing Drive Enclosures.

With each cabling step, Guided Maintenance displays an image that
identifies the SAS port to which you connect a SAS cable. Connect the SAS
cable as shown in Guided Maintenance. Also, ensure that you arrange the
cables so that all the power cooling modules and I/O modules can be
replaced without disrupting the cables.

4 After completing the steps in Guided Maintenance, click Finish.

Guided Maintenance closes and returns you to the Drive Enclosure
Overview page.
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5 Complete the expansion process.

6 Repeat the procedures for cabling a new Drive Enclosure for each Drive
Enclosure planned for the system expansion.

Related Links
Complete the Expansion Process
Overview of Cabling New Drive Enclosures

Cable a New Drive Enclosure (Manual)
If you do not use Guided Maintenance to add a new Drive Enclosure, carefully
follow the manual cabling sequences based on the Drive Enclosure number
within the string. Work with your Oracle Sales Engineer and refer to the
planning worksheet to determine the string assignments for each new Drive
Enclosures.

Prerequisites: • The steps for planning the system expansion are complete.
• The new Drive Enclosures are installed in the rack and

powered on.
• The cables are unpacked and you have the correct mini-

SAS to mini-SAS cables and mini-SAS to mini-SAS HD
cables for adding the Drive Enclosures to the system. Refer
to your system expansion plan for details.

If the Oracle FS System remained in production for the Drive Enclosure add
procedure, adding the second and third Drive Enclosure to a string requires the
system to re-route I/O traffic around the connections that are temporarily
disrupted. System connections are not interrupted when you add the first,
fourth, and fifth Drive Enclosure to a string.

Note: If the system remained in production, continually be aware of the state of
the system when adding Drive Enclosures. The configuration of the system has
dual paths for all of the required connections within the system. During parts of
the procedures for adding a Drive Enclosure, one of those paths might be
disabled. An error such as disconnecting the wrong cable can cause serious
problems to ongoing operation of the system.

Based on the planning worksheet defining the strings for the new Drive
Enclosures, cable the new Drive Enclosures one at a time. Follow the procedure
that corresponds with the Drive Enclosure number within the string.

Cabling sequences for new Drive Enclosures

1 Add the First Drive Enclosure to a New String

2 Add a Second Drive Enclosure to a String

3 Add a Third Drive Enclosure to a String

4 Add a Fourth Drive Enclosure to a String

Cabling New Drive Enclosures
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5 Add a Fifth Drive Enclosure to a String

6 Complete the Expansion Process

Related Links
Complete the Expansion Process
Overview of Cabling New Drive Enclosures
System Expansion Label Kit
SAS Cabling Precautions

Beaconing Drive Enclosures
If the Oracle FS System remained in production for the Drive Enclosure add
procedure, you can use the beaconing feature to ensure that you are working
with the correct Drive Enclosure before disconnecting any cables. The beaconing
feature in Oracle FS System Manager (GUI) or in Oracle FS CLI (FSCLI) helps
you locate Drive Enclosures in a rack and to double check which Drive
Enclosures are connected during each step of adding a Drive Enclosure.

During the beaconing process, the system flashes the LEDs on the specified Drive
Enclosure. The flashing LEDs help you locate the Drive Enclosure in the rack and
determine the cabling connection.

Note: For systems that remained in production for the Drive Enclosure add
procedure, you can use the beaconing feature for assistance with locating a
specific Drive Enclosure at any point while adding Drive Enclosures.

Flash LEDs on Drive Enclosures (GUI)

Use Oracle FS System Manager (GUI) to flash LEDs on a selected Drive
Enclosure. The flashing LEDs help you locate the Drive Enclosure in the rack.

1 Navigate to System > Hardware > Drive Enclosures.

2 Select the Drive Enclosure for which you want to flash LEDs.

3 Select Actions > Identify.

Guided Maintenance displays the Identify dialog.

4 Specify how you want to flash LEDs on the Drive Enclosure.

Select one of the following methods to flash LEDs:

Identify Flashes the LEDs on the selected Drive Enclosure.
Reverse
Identify

Flashes the LEDs on all of the Drive Enclosures in the
system except for the selected Drive Enclosure.

5 Click Next.

Based on the method you selected to flash LEDs, the corresponding LEDs
flash on the selected Drive Enclosure.

6 After you locate the Drive Enclosure, click Finish.

Cabling New Drive Enclosures

35



Flash LEDs on Drive Enclosures (FSCLI)

Use Oracle FS CLI (FSCLI) to flash the LEDs on a selected Drive Enclosure. The
flashing LEDs help you locate the Drive Enclosure in the rack.

1 From a command line, log into the FSCLI and issue fscli enclosure
‑beacon ‑enclosure /ENCLOSURE‑XX ‑chassis 0, where XX is the chassis
ID of the Drive Enclosure for which you want to flash the LEDs.

The LEDs flash on the specified Drive Enclosure.

To stop the LEDs flashing on a Drive Enclosure chassis, issue fscli
enclosure ‑beacon ‑enclosure /ENCLOSURE‑XX ‑stop ‑chassis 0.

2 To flash the LEDs of individual I/O modules on a Drive Enclosure, issue
fscli enclosure ‑beacon ‑enclosure /ENCLOSURE‑XX ‑iom <0 or 1>.

The LEDs flash on the specified I/O module of the Drive Enclosure.

To stop the LEDs flashing on the I/O module, issue fscli enclosure
‑beacon ‑enclosure /ENCLOSURE‑XX ‑IOM 0 ‑stop.

Add the First Drive Enclosure to a New String
The following example shows the steps for adding the first Drive Enclosure to a
new string.

In this example, the string connects to SAS HBA port 0 on the Controller nodes.
Depending on the string number and the configuration of the Controllers in your
system, the string connects to SAS HBA port 0 or SAS HBA port 1 on the
Controller nodes.

1 Using a mini-SAS to mini-SAS high density (HD) cable, connect the mini-
SAS HD end of the cable to port 0 in the SAS HBA on Controller 1.

Make sure to leave enough cable slack to ensure that the chassis can be
extended into the service position and returned to the rack position
without interference from the cables.

2 Route the cable through the cable management arm (CMA).

3 Connect the mini-SAS end of the cable to I/O module 0, port 0 on the new
Drive Enclosure.

4 Using a mini-SAS to mini-SAS HD cable, connect the mini-SAS HD end of
the cable to port 0 in the SAS HBA on Controller 2.

5 Route the cable through the CMA.

6 Connect the mini-SAS end of the cable to I/O module 1, port 0 on the new
Drive Enclosure.
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Figure 10: First Drive Enclosure and a new string

Legend 1 SAS HBA port on Controller 1 3 SAS HBA port on Controller 2

2 I/O module 0, port 0 on DE 1 4 I/O module 1, port 0 on DE 1

7 From a command line, issue fscli topology —list —violations.
If there are topology violations, correct them prior to proceeding.

8 Ensure that the cables do not obstruct access to the replaceable units in the
Drive Enclosure and the Controllers.

Add a Second Drive Enclosure to a String
The following example shows the steps for adding a second Drive Enclosure to
an existing string.

Note: The procedure involves disconnecting and reconnecting SAS cables. It can
take several minutes for the Oracle FS System to stabilize after disconnecting and
reconnecting SAS cables, especially when I/O is running.

In this example, the string connects to SAS HBA port 0 on the Controller nodes.
Depending on the string number and the configuration of the Controllers in your
system, the string connects to SAS HBA port 0 or SAS HBA port 1 on the
Controller nodes.

1 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 0, port 1 on Drive Enclosure 1 (DE 1).

Note: If the system remained in production, continually be aware of the
state of the system when adding Drive Enclosures. The configuration of the
system has dual paths for all of the required connections within the
system. During parts of the procedures for adding a Drive Enclosure, one
of those paths might be disabled. An error such as disconnecting the
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wrong cable can cause serious problems to ongoing operation of the
system.

2 Connect the other end of the cable to I/O module 0, port 0 on Drive
Enclosure 2 (DE 2).

Figure 11: First connection for second Drive Enclosure in a string

Legend 1 I/O module 0, port 1 on DE 1 2 I/O module 0, port 0 on DE 2

3 Disconnect the cable from I/O module 1, port 0 on DE 1.

4 Reconnect the cable to I/O module 1, port 0 on DE 2.
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Figure 12: Connection from SAS HBA to DE 2

Legend 1 I/O module 1, port 0 on DE 1 2 I/O module 1, port 0 on DE 2

5 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 1, port 0 on DE 1.

6 Connect the other end of the cable to I/O module 1, port 1 on DE 2.
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Figure 13: Final connection for second Drive Enclosure in string

Legend 1 I/O module 1, port 0 on DE 1 2 I/O module 1, port 1 on DE 2

7 From a command line, issue fscli topology —list —violations.
If there are topology violations, correct them prior to proceeding.

8 Ensure that the cables do not obstruct access to the replaceable units in the
Drive Enclosure and the Controllers.

Add a Third Drive Enclosure to a String
The following example shows the steps for adding a third Drive Enclosure to an
existing string.

Note: The procedure involves disconnecting and reconnecting SAS cables. It can
take several minutes for the Oracle FS System to stabilize after disconnecting and
reconnecting SAS cables, especially when I/O is running.

In this example, the string connects to SAS HBA port 0 on the Controller nodes.
Depending on the string number and the configuration of the Controllers in your
system, the string connects to SAS HBA port 0 or SAS HBA port 1 on the
Controller nodes.

1 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 0, port 1 on Drive Enclosure 2 (DE 2).

Note: If the system remained in production, continually be aware of the
state of the system when adding Drive Enclosures. The configuration of the
system has dual paths for all of the required connections within the
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system. During parts of the procedures for adding a Drive Enclosure, one
of those paths might be disabled. An error such as disconnecting the
wrong cable can cause serious problems to ongoing operation of the
system.

2 Connect the other end of the cable to I/O module 0, port 0 on Drive
Enclosure 3 (DE 3).

Figure 14: First connection between DE 2 and DE 3 in a string

Legend 1 I/O module 1, port 1 on DE 2 2 I/O module 0, port 0 on DE 3

3 Disconnect the mini-SAS cable from I/O module 1, port 0 on DE 2, and
connect the cable to I/O module 1, port 0 on DE 3.
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Figure 15: Connection from SAS HBA to DE 3

Legend 1 I/O module 1, port 0 on DE 2 2 I/O module 1, port 0 on DE 3

4 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 1, port 0 on DE 2.

5 Connect the other end of the cable to I/O module 1, port 1 on DE 3.
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Figure 16: Final connection for third Drive Enclosure in string

Legend 1 I/O module 1, port 0 on DE 2 2 I/O module 1, port 1 on DE 3

6 From a command line, issue fscli topology —list —violations.
If there are topology violations, correct them prior to proceeding.

7 Ensure that the cables do not obstruct access to the replaceable units in the
Drive Enclosure and the Controllers.

Add a Fourth Drive Enclosure to a String
The following example shows the steps for adding a fourth Drive Enclosure to an
existing string.

In this example, the string connects to SAS HBA port 0 on the Controller nodes.
Depending on the string number and the configuration of the Controllers in your
system, the string connects to SAS HBA port 0 or SAS HBA port 1 on the
Controller nodes.
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1 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 0, port 2 on Drive Enclosure 1 (DE 1).

2 Connect the other end of the cable to I/O module 0, port 0 on Drive
Enclosure 4 (DE 4).

3 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 1, port 2 on Drive Enclosure 2 (DE 2).

4 Connect the other end of the cable to I/O module 1, port 0 on Drive
Enclosure 4 (DE 4).

Figure 17: Connection for fourth Drive Enclosure in string
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Legend 1 I/O module 0, port 2 on DE 1 3 I/O module 1, port 2 on DE 2

2 I/O module 0, port 0 on DE 4 4 I/O module 1, port 0 on DE 4

5 From a command line, issue fscli topology —list —violations.
If there are topology violations, correct them prior to proceeding.

6 Ensure that the cables do not obstruct access to the replaceable units in the
Drive Enclosure and the Controllers.

Add a Fifth Drive Enclosure to a String
The following example shows the steps for adding a fifth Drive Enclosure to an
existing string.

In this example, the string connects to SAS HBA port 0 on the Controller nodes.
Depending on the string number and the configuration of the Controllers in your
system, the string connects to SAS HBA port 0 or SAS HBA port 1 on the
Controller nodes.

1 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 0, port 2 on the third Drive Enclosure (DE 3) in the string.

2 Connect the other end of the cable to I/O module 0, port 0 on the fifth Drive
Enclosure (DE 5).

3 Using a mini-SAS to mini-SAS cable, connect one end of the cable to I/O
module 1, port 2 on DE 3.

4 Connect the other end of the cable to I/O module 1, port 0 on DE 5.
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Figure 18: Connections for fifth Drive Enclosure in string

Legend 1 I/O module 0, port 2 on DE 3 3 I/O module 1, port 2 on DE 3

2 I/O module 0, port 0 on DE 5 4 I/O module 1, port 0 on DE 5

5 From a command line, issue fscli topology —list —violations.
If there are topology violations, correct them prior to proceeding.

6 Ensure that the cables do not obstruct access to the replaceable units in the
Drive Enclosure and the Controllers.
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Complete the Expansion Process
After cabling the new Drive Enclosures in the Oracle FS System, complete the
expansion process.

For more information involving the following steps, refer to Oracle Flash Storage
System CLI Reference and Oracle Flash Storage System Administrator’s Guide.

1 If you brought the system offline during the add procedure, restart the
system.

a) If you are using Oracle FS System Manager (GUI), select Oracle FS >
Restart.

b) If you are using Oracle FS CLI (FSCLI), issue fscli system
‑restart.

2 If the system remained in production during the add procedure, re-enable
Call-Home events.

a) If you are using the GUI, navigate to System > Networking.

b) Select Actions > Modify > Notifications.

c) Select the Enable event triggered Call-Home check box and click
OK.

d) If you are using the FSCLI, issue fscli call_home ‑modify
‑enableEventTrigger.

3 Accept the new drives into the system.
If you are using the GUI, complete the following steps:

a) Navigate to System > Alerts and Events > System Alerts.

b) Double-click the Foreign Disk Drive system alert.

c) Click Accept New Drives.

d) Click OK.

The system updates the statuses of each new drive and automatically
creates drive groups.

If you are using the FSCLI, complete the following steps:

a) Issue fscli system_alert –list –details to view the system
alert for foreign drives.

The alert displays the Drive Enclosure identifier and the foreign
drives.

b) Issue fscli enclosure ‑modify ‑enclosure
enclosure‑id‑or‑fqn ‑acceptDrive drive‑slot‑number
[, drive‑slot‑number]....

The system updates the statuses of each new drive and automatically
creates drive groups.
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4 Use the GUI to verify that the system discovers the newly added Drive
Enclosures.

a) Navigate to System > Hardware > Drive Enclosures.

b) From the Drive Enclosures Overview page, monitor the status of the
new Drive Enclosures as the system discovers them.

Verify that each Drive Enclosure has a status of Normal and the
drive groups have a status of Unassigned.

5 As necessary, arrange the drive groups into the Storage Domains where
extra storage is needed.

For more information about managing drive groups and Storage Domains,
refer to Oracle Flash Storage System Administrator’s Guide and Oracle Flash
Storage System CLI Reference.

When a volume is created, it is possible that the Oracle FS System provisions the
volume across fewer drive groups than the optimal number that would satisfy
the desired QoS settings for the volume. This situation can occur when an
insufficient number of drive groups are available in the Storage Domain in which
the volume is created.

However, when Drive Enclosures are added to that Storage Domain and Enable
Automatic QoS Rebalancing is enabled, the Oracle FS System attempts to correct
the sub-optimal provisioning. The correction is accomplished by scanning for all
volumes that are sub-optimally provisioned in that Storage Domain.

If certain conditions exist, the system begins migrating the data for those
volumes to the newly available drive groups that are provided by the new Drive
Enclosures. The scanning and the migration depend on the Storage Class of each
volume in the Storage Domain. The migration occurs only when sufficient free
space exists in the same Storage Class that is configured for the volume.

The QoS rebalance occurs during a daily scan; therefore, QoS rebalance might
not happen for up to 24 hours. However, as drive groups are added, you can
select Rebalance Volume Data in the GUI or FSCLI to take advantage of the new
storage without waiting for the daily scan. The Rebalance Volume Data function
only rebalances the volumes that are in the same Storage Classes as the new
drive groups and only if suboptimal volumes exist in the provisioning.

Related Links
Prepare the System for Cabling New Drive Enclosures

Cabling New Drive Enclosures
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CHAPTER 5

Adding Solid State Drives

SSD Expansion Kits
Solid state drives (SSDs) can be added to the Oracle FS System to expand the
storage pool. The SSD Expansion Kits provide SSDs, which are added to the
DE2-24P Drive Enclosures configured with seven SSDs (400GB or 1.6TB) or 13
SSDs (1.6TB).

The following types of SSDs are included in separate SSD Expansion Kits:

• Six disk performance SSDs (400GB)

• Six disk capacity SSDs (1.6TB)

Note: All of the SSDs within a Drive Enclosure must be the same capacity.

Add SSDs to a Drive Enclosure
To expand storage of an Oracle FS System, add SSDs to DE2-24P Drive
Enclosures configured with SSDs.

Prerequisite: You have identified a DE2-24P Drive Enclosure with available
slots for adding the SSDs.

1 Unpack the SSD Expansion Kit.

2 Working with one SSD at a time, insert the SSDs into the available Drive
Enclosure slots.

3 Accept the new drives into the system.
If you are using the GUI, complete the following steps:

a) Navigate to System > Alerts and Events > System Alerts.

b) Double-click the Foreign Disk Drive system alert.

c) Click Accept New Drives.

d) Click OK.

The system updates the statuses of each new drive and automatically
creates drive groups.

If you are using the FSCLI, complete the following steps:

a) Issue fscli system_alert –list –details to view the system
alert for foreign drives.
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The alert displays the Drive Enclosure identifier and the foreign
drives.

b) Issue fscli enclosure ‑modify ‑enclosure
enclosure‑id‑or‑fqn ‑acceptDrive drive‑slot‑number
[, drive‑slot‑number]....

The system updates the statuses of each new drive and automatically
creates drive groups.

4 As necessary, arrange the drive groups into the Storage Domains where
extra storage is needed.

For more information about managing drive groups and Storage Domains,
refer to Oracle Flash Storage System Administrator’s Guide and Oracle Flash
Storage System CLI Reference.

Adding Solid State Drives
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APPENDIX A

SAS HBAs and String Configuration

Controller Connection Ports and String Numbers
Factory configurations of the Oracle FS System adhere to specific connection
guidelines. In the factory configuration, Drive Enclosures are distributed among
all of the available strings. The number of available strings depends upon the
number of SAS HBAs installed on the Controllers.

One SAS HBA
The following table shows the relationship between the connections on the
Controllers with one SAS HBA installed and the distribution of Drive Enclosure
strings.

Table 10: One SAS HBA per Controller
String Number SAS HBA/PCIe slot Port number on the SAS HBA

1 HBA 0/Slot 3 0

2 HBA 0/Slot 3 1

The following figure shows an example of a Controller with one SAS HBA.

Figure 19: One SAS HBA per Controller, string numbers, and port numbers

Legend 1 String 1, PCIe3 slot 3, SAS HBA
port 0

2 String 2, PCIe3 slot 3, SAS HBA
port 1

51



Two SAS HBAs
The following table shows the relationship between the connections on the
Controllers with two SAS HBAs installed and the distribution of Drive Enclosure
strings.

Table 11: Two SAS HBAs per Controller
String Number SAS HBA/PCIe slot Port number on the SAS HBA

1 HBA0/Slot 3 0

2 HBA 1/Slot 6 0

3 HBA 0/Slot 3 1

4 HBA 1/Slot 6 1

The following figure shows an example of a Controller with two SAS HBAs.

Figure 20: Two SAS HBAs per Controller, string numbers, and port numbers

Legend 1 String 1, PCIe3 slot 3, SAS HBA
port 0

3 String 3, PCIe3 slot 3, SAS HBA
port 1

2 String 2, PCIe3 slot 6, SAS HBA
port 0

4 String 4, PCIe3 slot 6, SAS HBA
port 1

Three SAS HBAs and String Numbers
The following table shows the relationship between the connections on the
Controllers with three SAS HBAs installed and the distribution of Drive
Enclosure strings.

Table 12: Three SAS HBAs per Controller
String Number SAS HBA/PCIe slot Port number on the SAS HBA

1 HBA 0/Slot 3 0

2 HBA 1/Slot 6 0

3 HBA 2/Slot 2 0

SAS HBAs and String Configuration
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Table 12: Three SAS HBAs per Controller (continued)
4 HBA 0/Slot 3 1

5 HBA 1/Slot 6 1

6 HBA 2/Slot 2 1

The following figure shows the relationship between the Controller connection
ports with three SAS HBAs.

Figure 21: Three SAS HBAs per Controller, string numbers, and port numbers

Legend 1 String 1, PCIe3 slot 3, SAS HBA
port 0

4 String 4, PCIe3 slot 3, SAS HBA
port 1

2 String 2, PCIe3 slot 6, SAS HBA
port 0

5 String 5, PCIe3 slot 6, SAS HBA
port 1

3 String 3, PCIe3 slot 2, SAS HBA
port 0

6 String 6, PCIe3 slot 2, SAS HBA
port 1

SAS HBAs and String Configuration
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APPENDIX B

Topology Output

Sample Topology Output
The fscli topology -download -topoMap topomapfilename command
generates an output file that contains the connectivity maps of the Oracle FS
System. Work with your Oracle Sales Engineer to analyze the connectivity map,
verify the current topology of your system, and to determine where to add new
Drive Enclosures for system expansion.

Annotated Samples of Topology Output (Performance System)
The topology output file provides the following general information:

• Up to four connectivity maps generated at different times. The most recent
connectivity map is listed first in the output. In some cases, identical maps
might be generated.

• Sections that clearly delineate the connectivity details for the Controllers
and each Drive Enclosure in the system.

• The chassis IDs and the World Wide Node Names (WWN) of the
Controllers and the Drive Enclosures in the system. The chassis ID is the
two-digit number displayed on the front of the chassis. The WWN is a 16-
digit code that uniquely identifies each Controller
and Drive Enclosure.

• The connection entries indicate how each Controller HBA is connected to
the first Drive Enclosure of each string. The symbol <== ==> translates to
“is connected to.” For example, /CONTROLLER-01 508002000158BF40 :
HBA 0 : Port 0 <== ==> /ENCLOSURE-01 5080020001A9C9E5
[5080020001B5D1FF]: IOM 0 : Port 0 translates to “Controller 01,
HBA 0, port 0 is connected to DE-01, IOM 0, port 0.”

The following figure shows annotated details for the Controllers in the topology
output for a system configured with three SAS HBAs and 30 Drive Enclosures.
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Figure 22: Annotated example of Controller sections

Topology Output
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Legend 1 Date and timestamp of the first of up to four connectivity maps generated
in the topology output file for a system.

2 Sections for Controller 01 and Controller 02. The Controller sections
describe Controller’s view of its SAS connection details. The sections
provide the Controller ID, WWN, and the Drive Enclosure connection
details.

3 Section describing HBA’s view of the string data path connection details.
The section provides details for all ports supported on that HBA. Each HBA
has its own section.

4 Controller 01 connection to the first Drive Enclosure of string 1. HBA 0,
port 0 is the first Controller HBA port used, which connects to string 1.

5 Controller 01 connection to the first Drive Enclosure of string 4.

6 Connection details for SAS HBA ports 2 and 3, which are used for cache
mirroring and secondary data path access between the Controllers. SAS
HBA ports 2 and 3 cross connect to the corresponding HBA and ports on
the partner Controller.

The following figure shows annotated details for two of the Drive Enclosures in
the topology output for a system configured with three SAS HBAs and 30 Drive
Enclosures.

Topology Output
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Figure 23: Annotated example of Drive Enclosures

Topology Output
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Legend 1 Sections within the topology map that describe the data path connections
for each Drive Enclosure. Each section provides the chassis IDs, the WWN,
and the port connection details for both I/O module 0 and I/O module 1.

2 Section describing the data path connections for I/O module 0 data path
connections. The section provides the expander's unique ID and each port
connection for I/O module 0.

3 Section describing connection for I/O module 0, port 0. In this example, I/
O module 0, port 0 connects to Controller 01, HBA 0, port 0. The
connections should correspond with the Controller 01 entry in the
Controller 01 section above

4 Section describing the connections on I/O module 0, port 1 and port 2.
These are egress ports that connect to downstream Drive Enclosures within
the string.

5 Section describing the connections on I/O module 1 of Drive Enclosure 01.

6 Drive Enclosure 28’s connection to Controller 02. In this example, Drive
Enclosure 28 connects to HBA 2, port 1 on Controller 02, which makes it the
third Drive Enclosure within string 6. The connections should correspond
with the Controller 02 entry in the Controller 02 section above.

fscli topology –download –topomap Command (Sample)
The following example provides sample output of the complete topology for a
factory-configured system with three SAS HBAs and 30 Drive Enclosures.

When reviewing the sample output, follow the connection topology and not the
order of presentation. Keep in mind the following items regarding the order of
presentation in the output file:

• The output presents the strings in the order of 1, 4, 2, 5, 3, and 6.

• Within a string, the output presents the Drive Enclosures in the order of 1,
2, 3, 5, and 4.

Figure 24: System with three SAS HBAs and 30 Drive Enclosures (Sample)
Topology is updated at:
Fri Nov 21 02:00:17 2014
------- CONN MAP FOR /CONTROLLER-01 508002000158BF40 -------
Controller has 3 HBAs installed
HBA IDX 0 is installed in PCI slot 3
/CONTROLLER-01 508002000158BF40 : HBA 0 : Port 0 <==  ==> /
ENCLOSURE-01 5080020001A9C9E5 [5080020001B5D1FF]: IOM 0 : Port 0
/CONTROLLER-01 508002000158BF40 : HBA 0 : Port 1 <==  ==> /
ENCLOSURE-16 5080020001A9CA62 [5080020001B60ABF]: IOM 0 : Port 0
/CONTROLLER-01 508002000158BF40 : HBA 0 : Port 2 <==  ==> /
CONTROLLER-02 508002000158BF41 : HBA 0 : Port 2
/CONTROLLER-01 508002000158BF40 : HBA 0 : Port 3 <==  ==> /
CONTROLLER-02 508002000158BF41 : HBA 0 : Port 3
HBA IDX 1 is installed in PCI slot 6
/CONTROLLER-01 508002000158BF40 : HBA 1 : Port 0 <==  ==> /
ENCLOSURE-06 5080020001A9C9E1 [5080020001B6857F]: IOM 0 : Port 0

Topology Output
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/CONTROLLER-01 508002000158BF40 : HBA 1 : Port 1 <==  ==> /
ENCLOSURE-21 5080020001A9CA9F [5080020001B6053F]: IOM 0 : Port 0
/CONTROLLER-01 508002000158BF40 : HBA 1 : Port 2 <==  ==> /
CONTROLLER-02 508002000158BF41 : HBA 1 : Port 2
/CONTROLLER-01 508002000158BF40 : HBA 1 : Port 3 <==  ==> /
CONTROLLER-02 508002000158BF41 : HBA 1 : Port 3
HBA IDX 2 is installed in PCI slot 2
/CONTROLLER-01 508002000158BF40 : HBA 2 : Port 0 <==  ==> /
ENCLOSURE-11 5080020001A9CA9E [5080020001B605FF]: IOM 0 : Port 0
/CONTROLLER-01 508002000158BF40 : HBA 2 : Port 1 <==  ==> /
ENCLOSURE-26 5080020001A9C6AA [5080020001B313BF]: IOM 0 : Port 0
/CONTROLLER-01 508002000158BF40 : HBA 2 : Port 2 <==  ==> /
CONTROLLER-02 508002000158BF41 : HBA 2 : Port 2
/CONTROLLER-01 508002000158BF40 : HBA 2 : Port 3 <==  ==> /
CONTROLLER-02 508002000158BF41 : HBA 2 : Port 3

------- CONN MAP FOR /CONTROLLER-02 508002000158BF41 -------
Controller has 3 HBAs installed
HBA IDX 0 is installed in PCI slot 3
/CONTROLLER-02 508002000158BF41 : HBA 0 : Port 0 <==  ==> /
ENCLOSURE-03 5080020001A9CB2D [5080020001B5B67F]: IOM 1 : Port 0
/CONTROLLER-02 508002000158BF41 : HBA 0 : Port 1 <==  ==> /
ENCLOSURE-18 5080020001A9CAA1 [5080020001B61D7F]: IOM 1 : Port 0
/CONTROLLER-02 508002000158BF41 : HBA 0 : Port 2 <==  ==> /
CONTROLLER-01 508002000158BF40 : HBA 0 : Port 2
/CONTROLLER-02 508002000158BF41 : HBA 0 : Port 3 <==  ==> /
CONTROLLER-01 508002000158BF40 : HBA 0 : Port 3
HBA IDX 1 is installed in PCI slot 6
/CONTROLLER-02 508002000158BF41 : HBA 1 : Port 0 <==  ==> /
ENCLOSURE-08 5080020001A9CAF3 [5080020001B601FF]: IOM 1 : Port 0
/CONTROLLER-02 508002000158BF41 : HBA 1 : Port 1 <==  ==> /
ENCLOSURE-23 5080020001A9CA97 [5080020001B61FFF]: IOM 1 : Port 0
/CONTROLLER-02 508002000158BF41 : HBA 1 : Port 2 <==  ==> /
CONTROLLER-01 508002000158BF40 : HBA 1 : Port 2
/CONTROLLER-02 508002000158BF41 : HBA 1 : Port 3 <==  ==> /
CONTROLLER-01 508002000158BF40 : HBA 1 : Port 3
HBA IDX 2 is installed in PCI slot 2
/CONTROLLER-02 508002000158BF41 : HBA 2 : Port 0 <==  ==> /
ENCLOSURE-13 5080020001A9CA0F [5080020001B5B2FF]: IOM 1 : Port 0
/CONTROLLER-02 508002000158BF41 : HBA 2 : Port 1 <==  ==> /
ENCLOSURE-28 5080020001A9CA9A [5080020001B6203F]: IOM 1 : Port 0
/CONTROLLER-02 508002000158BF41 : HBA 2 : Port 2 <==  ==> /
CONTROLLER-01 508002000158BF40 : HBA 2 : Port 2
/CONTROLLER-02 508002000158BF41 : HBA 2 : Port 3 <==  ==> /
CONTROLLER-01 508002000158BF40 : HBA 2 : Port 3

------- CONN MAP FOR /ENCLOSURE-01 5080020001A9C9E5 -------
Enclosure 5080020001A9C9E5 IOM 0 is Expander 5080020001B5D1FF
/ENCLOSURE-01   5080020001A9C9E5 [5080020001B5D1FF] : IOM 0 : 
Port 0 <==  ==> /CONTROLLER-01 508002000158BF40 : HBA 0 : Port 0
/ENCLOSURE-01   5080020001A9C9E5 [5080020001B5D1FF] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-02 5080020001A9C99D 
[5080020001B63F7F]: IOM 0 : Port 0
/ENCLOSURE-01   5080020001A9C9E5 [5080020001B5D1FF] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-04 5080020001A9CAF1 
[5080020001B3C4FF]: IOM 0 : Port 0
Enclosure 5080020001A9C9E5 IOM 1 is Expander 5080020001B67EBF
/ENCLOSURE-01   5080020001A9C9E5 [5080020001B67EBF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-02 5080020001A9C99D 
[5080020001B645FF]: IOM 1 : Port 1
/ENCLOSURE-01   5080020001A9C9E5 [5080020001B67EBF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-01   5080020001A9C9E5 [5080020001B67EBF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

Topology Output

59



------- CONN MAP FOR /ENCLOSURE-02 5080020001A9C99D -------
Enclosure 5080020001A9C99D IOM 0 is Expander 5080020001B63F7F
/ENCLOSURE-02   5080020001A9C99D [5080020001B63F7F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-01 5080020001A9C9E5 
[5080020001B5D1FF]: IOM 0 : Port 1
/ENCLOSURE-02   5080020001A9C99D [5080020001B63F7F] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-03 5080020001A9CB2D 
[5080020001B5CD3F]: IOM 0 : Port 0
/ENCLOSURE-02   5080020001A9C99D [5080020001B63F7F] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-05 5080020001A9C994 
[5080020001B63DFF]: IOM 0 : Port 0
Enclosure 5080020001A9C99D IOM 1 is Expander 5080020001B645FF
/ENCLOSURE-02   5080020001A9C99D [5080020001B645FF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-03 5080020001A9CB2D 
[5080020001B5B67F]: IOM 1 : Port 1
/ENCLOSURE-02   5080020001A9C99D [5080020001B645FF] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-01 5080020001A9C9E5 
[5080020001B67EBF]: IOM 1 : Port 0
/ENCLOSURE-02   5080020001A9C99D [5080020001B645FF] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-04 5080020001A9CAF1 
[5080020001B6147F]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-03 5080020001A9CB2D -------
Enclosure 5080020001A9CB2D IOM 0 is Expander 5080020001B5CD3F
/ENCLOSURE-03   5080020001A9CB2D [5080020001B5CD3F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-02 5080020001A9C99D 
[5080020001B63F7F]: IOM 0 : Port 1
/ENCLOSURE-03   5080020001A9CB2D [5080020001B5CD3F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-03   5080020001A9CB2D [5080020001B5CD3F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CB2D IOM 1 is Expander 5080020001B5B67F
/ENCLOSURE-03   5080020001A9CB2D [5080020001B5B67F] : IOM 1 : 
Port 0 <==  ==> /CONTROLLER-02 508002000158BF41 : HBA 0 : Port 0
/ENCLOSURE-03   5080020001A9CB2D [5080020001B5B67F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-02 5080020001A9C99D 
[5080020001B645FF]: IOM 1 : Port 0
/ENCLOSURE-03   5080020001A9CB2D [5080020001B5B67F] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-05 5080020001A9C994 
[5080020001B64C7F]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-05 5080020001A9C994 -------
Enclosure 5080020001A9C994 IOM 0 is Expander 5080020001B63DFF
/ENCLOSURE-05   5080020001A9C994 [5080020001B63DFF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-02 5080020001A9C99D 
[5080020001B63F7F]: IOM 0 : Port 2
/ENCLOSURE-05   5080020001A9C994 [5080020001B63DFF] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-05   5080020001A9C994 [5080020001B63DFF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9C994 IOM 1 is Expander 5080020001B64C7F
/ENCLOSURE-05   5080020001A9C994 [5080020001B64C7F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-03 5080020001A9CB2D 
[5080020001B5B67F]: IOM 1 : Port 2
/ENCLOSURE-05   5080020001A9C994 [5080020001B64C7F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-05   5080020001A9C994 [5080020001B64C7F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-04 5080020001A9CAF1 -------
Enclosure 5080020001A9CAF1 IOM 0 is Expander 5080020001B3C4FF
/ENCLOSURE-04   5080020001A9CAF1 [5080020001B3C4FF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-01 5080020001A9C9E5 
[5080020001B5D1FF]: IOM 0 : Port 2
/ENCLOSURE-04   5080020001A9CAF1 [5080020001B3C4FF] : IOM 0 : 

Topology Output

60



Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-04   5080020001A9CAF1 [5080020001B3C4FF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CAF1 IOM 1 is Expander 5080020001B6147F
/ENCLOSURE-04   5080020001A9CAF1 [5080020001B6147F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-02 5080020001A9C99D 
[5080020001B645FF]: IOM 1 : Port 2
/ENCLOSURE-04   5080020001A9CAF1 [5080020001B6147F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-04   5080020001A9CAF1 [5080020001B6147F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-16 5080020001A9CA62 -------
Enclosure 5080020001A9CA62 IOM 0 is Expander 5080020001B60ABF
/ENCLOSURE-16   5080020001A9CA62 [5080020001B60ABF] : IOM 0 : 
Port 0 <==  ==> /CONTROLLER-01 508002000158BF40 : HBA 0 : Port 1
/ENCLOSURE-16   5080020001A9CA62 [5080020001B60ABF] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-17 5080020001A9CB10 
[5080020001B5F87F]: IOM 0 : Port 0
/ENCLOSURE-16   5080020001A9CA62 [5080020001B60ABF] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-19 5080020001A9CA98 
[5080020001B6327F]: IOM 0 : Port 0
Enclosure 5080020001A9CA62 IOM 1 is Expander 5080020001B60F3F
/ENCLOSURE-16   5080020001A9CA62 [5080020001B60F3F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-17 5080020001A9CB10 
[5080020001B5FC3F]: IOM 1 : Port 1
/ENCLOSURE-16   5080020001A9CA62 [5080020001B60F3F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-16   5080020001A9CA62 [5080020001B60F3F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-17 5080020001A9CB10 -------
Enclosure 5080020001A9CB10 IOM 0 is Expander 5080020001B5F87F
/ENCLOSURE-17   5080020001A9CB10 [5080020001B5F87F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-16 5080020001A9CA62 
[5080020001B60ABF]: IOM 0 : Port 1
/ENCLOSURE-17   5080020001A9CB10 [5080020001B5F87F] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-18 5080020001A9CAA1 
[5080020001B6077F]: IOM 0 : Port 0
/ENCLOSURE-17   5080020001A9CB10 [5080020001B5F87F] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-20 5080020001A9C53F 
[5080020001A8653F]: IOM 0 : Port 0
Enclosure 5080020001A9CB10 IOM 1 is Expander 5080020001B5FC3F
/ENCLOSURE-17   5080020001A9CB10 [5080020001B5FC3F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-18 5080020001A9CAA1 
[5080020001B61D7F]: IOM 1 : Port 1
/ENCLOSURE-17   5080020001A9CB10 [5080020001B5FC3F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-16 5080020001A9CA62 
[5080020001B60F3F]: IOM 1 : Port 0
/ENCLOSURE-17   5080020001A9CB10 [5080020001B5FC3F] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-19 5080020001A9CA98 
[5080020001B625BF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-18 5080020001A9CAA1 -------
Enclosure 5080020001A9CAA1 IOM 0 is Expander 5080020001B6077F
/ENCLOSURE-18   5080020001A9CAA1 [5080020001B6077F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-17 5080020001A9CB10 
[5080020001B5F87F]: IOM 0 : Port 1
/ENCLOSURE-18   5080020001A9CAA1 [5080020001B6077F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-18   5080020001A9CAA1 [5080020001B6077F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CAA1 IOM 1 is Expander 5080020001B61D7F
/ENCLOSURE-18   5080020001A9CAA1 [5080020001B61D7F] : IOM 1 : 
Port 0 <==  ==> /CONTROLLER-02 508002000158BF41 : HBA 0 : Port 1
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/ENCLOSURE-18   5080020001A9CAA1 [5080020001B61D7F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-17 5080020001A9CB10 
[5080020001B5FC3F]: IOM 1 : Port 0
/ENCLOSURE-18   5080020001A9CAA1 [5080020001B61D7F] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-20 5080020001A9C53F 
[5080020001A857FF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-20 5080020001A9C53F -------
Enclosure 5080020001A9C53F IOM 0 is Expander 5080020001A8653F
/ENCLOSURE-20   5080020001A9C53F [5080020001A8653F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-17 5080020001A9CB10 
[5080020001B5F87F]: IOM 0 : Port 2
/ENCLOSURE-20   5080020001A9C53F [5080020001A8653F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-20   5080020001A9C53F [5080020001A8653F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9C53F IOM 1 is Expander 5080020001A857FF
/ENCLOSURE-20   5080020001A9C53F [5080020001A857FF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-18 5080020001A9CAA1 
[5080020001B61D7F]: IOM 1 : Port 2
/ENCLOSURE-20   5080020001A9C53F [5080020001A857FF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-20   5080020001A9C53F [5080020001A857FF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-19 5080020001A9CA98 -------
Enclosure 5080020001A9CA98 IOM 0 is Expander 5080020001B6327F
/ENCLOSURE-19   5080020001A9CA98 [5080020001B6327F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-16 5080020001A9CA62 
[5080020001B60ABF]: IOM 0 : Port 2
/ENCLOSURE-19   5080020001A9CA98 [5080020001B6327F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-19   5080020001A9CA98 [5080020001B6327F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CA98 IOM 1 is Expander 5080020001B625BF
/ENCLOSURE-19   5080020001A9CA98 [5080020001B625BF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-17 5080020001A9CB10 
[5080020001B5FC3F]: IOM 1 : Port 2
/ENCLOSURE-19   5080020001A9CA98 [5080020001B625BF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-19   5080020001A9CA98 [5080020001B625BF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-06 5080020001A9C9E1 -------
Enclosure 5080020001A9C9E1 IOM 0 is Expander 5080020001B6857F
/ENCLOSURE-06   5080020001A9C9E1 [5080020001B6857F] : IOM 0 : 
Port 0 <==  ==> /CONTROLLER-01 508002000158BF40 : HBA 1 : Port 0
/ENCLOSURE-06   5080020001A9C9E1 [5080020001B6857F] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-07 5080020001A9C9C3 
[5080020001B6D0FF]: IOM 0 : Port 0
/ENCLOSURE-06   5080020001A9C9E1 [5080020001B6857F] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-09 5080020001A9CAEF 
[5080020001B60B7F]: IOM 0 : Port 0
Enclosure 5080020001A9C9E1 IOM 1 is Expander 5080020001B6B8FF
/ENCLOSURE-06   5080020001A9C9E1 [5080020001B6B8FF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-07 5080020001A9C9C3 
[5080020001B5C87F]: IOM 1 : Port 1
/ENCLOSURE-06   5080020001A9C9E1 [5080020001B6B8FF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-06   5080020001A9C9E1 [5080020001B6B8FF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-07 5080020001A9C9C3 -------
Enclosure 5080020001A9C9C3 IOM 0 is Expander 5080020001B6D0FF

Topology Output

62



/ENCLOSURE-07   5080020001A9C9C3 [5080020001B6D0FF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-06 5080020001A9C9E1 
[5080020001B6857F]: IOM 0 : Port 1
/ENCLOSURE-07   5080020001A9C9C3 [5080020001B6D0FF] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-08 5080020001A9CAF3 
[5080020001B41CFF]: IOM 0 : Port 0
/ENCLOSURE-07   5080020001A9C9C3 [5080020001B6D0FF] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-10 5080020001A9C9EA 
[5080020001B5CFBF]: IOM 0 : Port 0
Enclosure 5080020001A9C9C3 IOM 1 is Expander 5080020001B5C87F
/ENCLOSURE-07   5080020001A9C9C3 [5080020001B5C87F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-08 5080020001A9CAF3 
[5080020001B601FF]: IOM 1 : Port 1
/ENCLOSURE-07   5080020001A9C9C3 [5080020001B5C87F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-06 5080020001A9C9E1 
[5080020001B6B8FF]: IOM 1 : Port 0
/ENCLOSURE-07   5080020001A9C9C3 [5080020001B5C87F] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-09 5080020001A9CAEF 
[5080020001B5F8FF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-08 5080020001A9CAF3 -------
Enclosure 5080020001A9CAF3 IOM 0 is Expander 5080020001B41CFF
/ENCLOSURE-08   5080020001A9CAF3 [5080020001B41CFF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-07 5080020001A9C9C3 
[5080020001B6D0FF]: IOM 0 : Port 1
/ENCLOSURE-08   5080020001A9CAF3 [5080020001B41CFF] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-08   5080020001A9CAF3 [5080020001B41CFF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CAF3 IOM 1 is Expander 5080020001B601FF
/ENCLOSURE-08   5080020001A9CAF3 [5080020001B601FF] : IOM 1 : 
Port 0 <==  ==> /CONTROLLER-02 508002000158BF41 : HBA 1 : Port 0
/ENCLOSURE-08   5080020001A9CAF3 [5080020001B601FF] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-07 5080020001A9C9C3 
[5080020001B5C87F]: IOM 1 : Port 0
/ENCLOSURE-08   5080020001A9CAF3 [5080020001B601FF] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-10 5080020001A9C9EA 
[5080020001B5CB3F]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-10 5080020001A9C9EA -------
Enclosure 5080020001A9C9EA IOM 0 is Expander 5080020001B5CFBF
/ENCLOSURE-10   5080020001A9C9EA [5080020001B5CFBF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-07 5080020001A9C9C3 
[5080020001B6D0FF]: IOM 0 : Port 2
/ENCLOSURE-10   5080020001A9C9EA [5080020001B5CFBF] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-10   5080020001A9C9EA [5080020001B5CFBF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9C9EA IOM 1 is Expander 5080020001B5CB3F
/ENCLOSURE-10   5080020001A9C9EA [5080020001B5CB3F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-08 5080020001A9CAF3 
[5080020001B601FF]: IOM 1 : Port 2
/ENCLOSURE-10   5080020001A9C9EA [5080020001B5CB3F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-10   5080020001A9C9EA [5080020001B5CB3F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-09 5080020001A9CAEF -------
Enclosure 5080020001A9CAEF IOM 0 is Expander 5080020001B60B7F
/ENCLOSURE-09   5080020001A9CAEF [5080020001B60B7F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-06 5080020001A9C9E1 
[5080020001B6857F]: IOM 0 : Port 2
/ENCLOSURE-09   5080020001A9CAEF [5080020001B60B7F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-09   5080020001A9CAEF [5080020001B60B7F] : IOM 0 : 
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Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CAEF IOM 1 is Expander 5080020001B5F8FF
/ENCLOSURE-09   5080020001A9CAEF [5080020001B5F8FF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-07 5080020001A9C9C3 
[5080020001B5C87F]: IOM 1 : Port 2
/ENCLOSURE-09   5080020001A9CAEF [5080020001B5F8FF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-09   5080020001A9CAEF [5080020001B5F8FF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-21 5080020001A9CA9F -------
Enclosure 5080020001A9CA9F IOM 0 is Expander 5080020001B6053F
/ENCLOSURE-21   5080020001A9CA9F [5080020001B6053F] : IOM 0 : 
Port 0 <==  ==> /CONTROLLER-01 508002000158BF40 : HBA 1 : Port 1
/ENCLOSURE-21   5080020001A9CA9F [5080020001B6053F] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-22 5080020001A9CA8E 
[5080020001B61A7F]: IOM 0 : Port 0
/ENCLOSURE-21   5080020001A9CA9F [5080020001B6053F] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-24 5080020001A9C9B9 
[5080020001B5E47F]: IOM 0 : Port 0
Enclosure 5080020001A9CA9F IOM 1 is Expander 5080020001B60A3F
/ENCLOSURE-21   5080020001A9CA9F [5080020001B60A3F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-22 5080020001A9CA8E 
[5080020001B6153F]: IOM 1 : Port 1
/ENCLOSURE-21   5080020001A9CA9F [5080020001B60A3F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-21   5080020001A9CA9F [5080020001B60A3F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-22 5080020001A9CA8E -------
Enclosure 5080020001A9CA8E IOM 0 is Expander 5080020001B61A7F
/ENCLOSURE-22   5080020001A9CA8E [5080020001B61A7F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-21 5080020001A9CA9F 
[5080020001B6053F]: IOM 0 : Port 1
/ENCLOSURE-22   5080020001A9CA8E [5080020001B61A7F] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-23 5080020001A9CA97 
[5080020001B626BF]: IOM 0 : Port 0
/ENCLOSURE-22   5080020001A9CA8E [5080020001B61A7F] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-25 5080020001A9CC78 
[5080020001B51C7F]: IOM 0 : Port 0
Enclosure 5080020001A9CA8E IOM 1 is Expander 5080020001B6153F
/ENCLOSURE-22   5080020001A9CA8E [5080020001B6153F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-23 5080020001A9CA97 
[5080020001B61FFF]: IOM 1 : Port 1
/ENCLOSURE-22   5080020001A9CA8E [5080020001B6153F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-21 5080020001A9CA9F 
[5080020001B60A3F]: IOM 1 : Port 0
/ENCLOSURE-22   5080020001A9CA8E [5080020001B6153F] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-24 5080020001A9C9B9 
[5080020001B5E3FF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-23 5080020001A9CA97 -------
Enclosure 5080020001A9CA97 IOM 0 is Expander 5080020001B626BF
/ENCLOSURE-23   5080020001A9CA97 [5080020001B626BF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-22 5080020001A9CA8E 
[5080020001B61A7F]: IOM 0 : Port 1
/ENCLOSURE-23   5080020001A9CA97 [5080020001B626BF] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-23   5080020001A9CA97 [5080020001B626BF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CA97 IOM 1 is Expander 5080020001B61FFF
/ENCLOSURE-23   5080020001A9CA97 [5080020001B61FFF] : IOM 1 : 
Port 0 <==  ==> /CONTROLLER-02 508002000158BF41 : HBA 1 : Port 1
/ENCLOSURE-23   5080020001A9CA97 [5080020001B61FFF] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-22 5080020001A9CA8E 
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[5080020001B6153F]: IOM 1 : Port 0
/ENCLOSURE-23   5080020001A9CA97 [5080020001B61FFF] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-25 5080020001A9CC78 
[5080020001B5AEFF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-25 5080020001A9CC78 -------
Enclosure 5080020001A9CC78 IOM 0 is Expander 5080020001B51C7F
/ENCLOSURE-25   5080020001A9CC78 [5080020001B51C7F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-22 5080020001A9CA8E 
[5080020001B61A7F]: IOM 0 : Port 2
/ENCLOSURE-25   5080020001A9CC78 [5080020001B51C7F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-25   5080020001A9CC78 [5080020001B51C7F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CC78 IOM 1 is Expander 5080020001B5AEFF
/ENCLOSURE-25   5080020001A9CC78 [5080020001B5AEFF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-23 5080020001A9CA97 
[5080020001B61FFF]: IOM 1 : Port 2
/ENCLOSURE-25   5080020001A9CC78 [5080020001B5AEFF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-25   5080020001A9CC78 [5080020001B5AEFF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-24 5080020001A9C9B9 -------
Enclosure 5080020001A9C9B9 IOM 0 is Expander 5080020001B5E47F
/ENCLOSURE-24   5080020001A9C9B9 [5080020001B5E47F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-21 5080020001A9CA9F 
[5080020001B6053F]: IOM 0 : Port 2
/ENCLOSURE-24   5080020001A9C9B9 [5080020001B5E47F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-24   5080020001A9C9B9 [5080020001B5E47F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9C9B9 IOM 1 is Expander 5080020001B5E3FF
/ENCLOSURE-24   5080020001A9C9B9 [5080020001B5E3FF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-22 5080020001A9CA8E 
[5080020001B6153F]: IOM 1 : Port 2
/ENCLOSURE-24   5080020001A9C9B9 [5080020001B5E3FF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-24   5080020001A9C9B9 [5080020001B5E3FF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-11 5080020001A9CA9E -------
Enclosure 5080020001A9CA9E IOM 0 is Expander 5080020001B605FF
/ENCLOSURE-11   5080020001A9CA9E [5080020001B605FF] : IOM 0 : 
Port 0 <==  ==> /CONTROLLER-01 508002000158BF40 : HBA 2 : Port 0
/ENCLOSURE-11   5080020001A9CA9E [5080020001B605FF] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-12 50800200019EFD06 
[5080020001A180BF]: IOM 0 : Port 0
/ENCLOSURE-11   5080020001A9CA9E [5080020001B605FF] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-14 5080020001A9CAAA 
[5080020001B61C7F]: IOM 0 : Port 0
Enclosure 5080020001A9CA9E IOM 1 is Expander 5080020001B601BF
/ENCLOSURE-11   5080020001A9CA9E [5080020001B601BF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-12 50800200019EFD06 
[5080020001A1927F]: IOM 1 : Port 1
/ENCLOSURE-11   5080020001A9CA9E [5080020001B601BF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-11   5080020001A9CA9E [5080020001B601BF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-12 50800200019EFD06 -------
Enclosure 50800200019EFD06 IOM 0 is Expander 5080020001A180BF
/ENCLOSURE-12   50800200019EFD06 [5080020001A180BF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-11 5080020001A9CA9E 
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[5080020001B605FF]: IOM 0 : Port 1
/ENCLOSURE-12   50800200019EFD06 [5080020001A180BF] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-13 5080020001A9CA0F 
[5080020001B5B53F]: IOM 0 : Port 0
/ENCLOSURE-12   50800200019EFD06 [5080020001A180BF] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-15 508002000168917C 
[508002000167F9FF]: IOM 0 : Port 0
Enclosure 50800200019EFD06 IOM 1 is Expander 5080020001A1927F
/ENCLOSURE-12   50800200019EFD06 [5080020001A1927F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-13 5080020001A9CA0F 
[5080020001B5B2FF]: IOM 1 : Port 1
/ENCLOSURE-12   50800200019EFD06 [5080020001A1927F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-11 5080020001A9CA9E 
[5080020001B601BF]: IOM 1 : Port 0
/ENCLOSURE-12   50800200019EFD06 [5080020001A1927F] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-14 5080020001A9CAAA 
[5080020001B616BF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-13 5080020001A9CA0F -------
Enclosure 5080020001A9CA0F IOM 0 is Expander 5080020001B5B53F
/ENCLOSURE-13   5080020001A9CA0F [5080020001B5B53F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-12 50800200019EFD06 
[5080020001A180BF]: IOM 0 : Port 1
/ENCLOSURE-13   5080020001A9CA0F [5080020001B5B53F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-13   5080020001A9CA0F [5080020001B5B53F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CA0F IOM 1 is Expander 5080020001B5B2FF
/ENCLOSURE-13   5080020001A9CA0F [5080020001B5B2FF] : IOM 1 : 
Port 0 <==  ==> /CONTROLLER-02 508002000158BF41 : HBA 2 : Port 0
/ENCLOSURE-13   5080020001A9CA0F [5080020001B5B2FF] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-12 50800200019EFD06 
[5080020001A1927F]: IOM 1 : Port 0
/ENCLOSURE-13   5080020001A9CA0F [5080020001B5B2FF] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-15 508002000168917C 
[508002000167FA7F]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-15 508002000168917C -------
Enclosure 508002000168917C IOM 0 is Expander 508002000167F9FF
/ENCLOSURE-15   508002000168917C [508002000167F9FF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-12 50800200019EFD06 
[5080020001A180BF]: IOM 0 : Port 2
/ENCLOSURE-15   508002000168917C [508002000167F9FF] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-15   508002000168917C [508002000167F9FF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 508002000168917C IOM 1 is Expander 508002000167FA7F
/ENCLOSURE-15   508002000168917C [508002000167FA7F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-13 5080020001A9CA0F 
[5080020001B5B2FF]: IOM 1 : Port 2
/ENCLOSURE-15   508002000168917C [508002000167FA7F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-15   508002000168917C [508002000167FA7F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-14 5080020001A9CAAA -------
Enclosure 5080020001A9CAAA IOM 0 is Expander 5080020001B61C7F
/ENCLOSURE-14   5080020001A9CAAA [5080020001B61C7F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-11 5080020001A9CA9E 
[5080020001B605FF]: IOM 0 : Port 2
/ENCLOSURE-14   5080020001A9CAAA [5080020001B61C7F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-14   5080020001A9CAAA [5080020001B61C7F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CAAA IOM 1 is Expander 5080020001B616BF
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/ENCLOSURE-14   5080020001A9CAAA [5080020001B616BF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-12 50800200019EFD06 
[5080020001A1927F]: IOM 1 : Port 2
/ENCLOSURE-14   5080020001A9CAAA [5080020001B616BF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-14   5080020001A9CAAA [5080020001B616BF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-26 5080020001A9C6AA -------
Enclosure 5080020001A9C6AA IOM 0 is Expander 5080020001B313BF
/ENCLOSURE-26   5080020001A9C6AA [5080020001B313BF] : IOM 0 : 
Port 0 <==  ==> /CONTROLLER-01 508002000158BF40 : HBA 2 : Port 1
/ENCLOSURE-26   5080020001A9C6AA [5080020001B313BF] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-27 5080020001A9CA66 
[5080020001B6123F]: IOM 0 : Port 0
/ENCLOSURE-26   5080020001A9C6AA [5080020001B313BF] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-29 5080020001A9CAA6 
[5080020001B61FBF]: IOM 0 : Port 0
Enclosure 5080020001A9C6AA IOM 1 is Expander 5080020001B37EBF
/ENCLOSURE-26   5080020001A9C6AA [5080020001B37EBF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-27 5080020001A9CA66 
[5080020001B5EEBF]: IOM 1 : Port 1
/ENCLOSURE-26   5080020001A9C6AA [5080020001B37EBF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-26   5080020001A9C6AA [5080020001B37EBF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-27 5080020001A9CA66 -------
Enclosure 5080020001A9CA66 IOM 0 is Expander 5080020001B6123F
/ENCLOSURE-27   5080020001A9CA66 [5080020001B6123F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-26 5080020001A9C6AA 
[5080020001B313BF]: IOM 0 : Port 1
/ENCLOSURE-27   5080020001A9CA66 [5080020001B6123F] : IOM 0 : 
Port 1 <==  ==> /ENCLOSURE-28 5080020001A9CA9A 
[5080020001B6277F]: IOM 0 : Port 0
/ENCLOSURE-27   5080020001A9CA66 [5080020001B6123F] : IOM 0 : 
Port 2 <==  ==> /ENCLOSURE-30 5080020001A9CBA2 
[5080020001B6117F]: IOM 0 : Port 0
Enclosure 5080020001A9CA66 IOM 1 is Expander 5080020001B5EEBF
/ENCLOSURE-27   5080020001A9CA66 [5080020001B5EEBF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-28 5080020001A9CA9A 
[5080020001B6203F]: IOM 1 : Port 1
/ENCLOSURE-27   5080020001A9CA66 [5080020001B5EEBF] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-26 5080020001A9C6AA 
[5080020001B37EBF]: IOM 1 : Port 0
/ENCLOSURE-27   5080020001A9CA66 [5080020001B5EEBF] : IOM 1 : 
Port 2 <==  ==> /ENCLOSURE-29 5080020001A9CAA6 
[5080020001B6263F]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-28 5080020001A9CA9A -------
Enclosure 5080020001A9CA9A IOM 0 is Expander 5080020001B6277F
/ENCLOSURE-28   5080020001A9CA9A [5080020001B6277F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-27 5080020001A9CA66 
[5080020001B6123F]: IOM 0 : Port 1
/ENCLOSURE-28   5080020001A9CA9A [5080020001B6277F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-28   5080020001A9CA9A [5080020001B6277F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CA9A IOM 1 is Expander 5080020001B6203F
/ENCLOSURE-28   5080020001A9CA9A [5080020001B6203F] : IOM 1 : 
Port 0 <==  ==> /CONTROLLER-02 508002000158BF41 : HBA 2 : Port 1
/ENCLOSURE-28   5080020001A9CA9A [5080020001B6203F] : IOM 1 : 
Port 1 <==  ==> /ENCLOSURE-27 5080020001A9CA66 
[5080020001B5EEBF]: IOM 1 : Port 0
/ENCLOSURE-28   5080020001A9CA9A [5080020001B6203F] : IOM 1 : 
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Port 2 <==  ==> /ENCLOSURE-30 5080020001A9CBA2 
[5080020001B3FEBF]: IOM 1 : Port 0

------- CONN MAP FOR /ENCLOSURE-30 5080020001A9CBA2 -------
Enclosure 5080020001A9CBA2 IOM 0 is Expander 5080020001B6117F
/ENCLOSURE-30   5080020001A9CBA2 [5080020001B6117F] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-27 5080020001A9CA66 
[5080020001B6123F]: IOM 0 : Port 2
/ENCLOSURE-30   5080020001A9CBA2 [5080020001B6117F] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-30   5080020001A9CBA2 [5080020001B6117F] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CBA2 IOM 1 is Expander 5080020001B3FEBF
/ENCLOSURE-30   5080020001A9CBA2 [5080020001B3FEBF] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-28 5080020001A9CA9A 
[5080020001B6203F]: IOM 1 : Port 2
/ENCLOSURE-30   5080020001A9CBA2 [5080020001B3FEBF] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-30   5080020001A9CBA2 [5080020001B3FEBF] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED

------- CONN MAP FOR /ENCLOSURE-29 5080020001A9CAA6 -------
Enclosure 5080020001A9CAA6 IOM 0 is Expander 5080020001B61FBF
/ENCLOSURE-29   5080020001A9CAA6 [5080020001B61FBF] : IOM 0 : 
Port 0 <==  ==> /ENCLOSURE-26 5080020001A9C6AA 
[5080020001B313BF]: IOM 0 : Port 2
/ENCLOSURE-29   5080020001A9CAA6 [5080020001B61FBF] : IOM 0 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-29   5080020001A9CAA6 [5080020001B61FBF] : IOM 0 : 
Port 2 <==  ==> DISCONNECTED
Enclosure 5080020001A9CAA6 IOM 1 is Expander 5080020001B6263F
/ENCLOSURE-29   5080020001A9CAA6 [5080020001B6263F] : IOM 1 : 
Port 0 <==  ==> /ENCLOSURE-27 5080020001A9CA66 
[5080020001B5EEBF]: IOM 1 : Port 2
/ENCLOSURE-29   5080020001A9CAA6 [5080020001B6263F] : IOM 1 : 
Port 1 <==  ==> DISCONNECTED
/ENCLOSURE-29   5080020001A9CAA6 [5080020001B6263F] : IOM 1 : 
Port 2 <==  ==> DISCONNECTED
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